
Understanding the iLinc Client 
The iLinc Client is the virtual room in which you collaborate and communicate during an online 
session. The Client is a small piece of software that is automatically installed on your computer 
when you join a session. The session room looks slightly different depending on the iLinc 
session type you are attending (i.e., MeetingLinc, LearnLinc, ConferenceLinc, or SupportLinc). 
   

 
Figure 15: iLinc Client 

   

Joining a Session 
You can join a session three ways: 

1. Join Using an Invitation E-mail Link  

2. Join from Your Communications Center Home Page  

3. Join from the Public Sessions Page  
   
If this is the first time you are joining an iLinc session, the iLinc Client software will install 
when you click the Join link. Depending on the settings established by your site administrator, 
you may need to download and install either a Java application or an ActiveX control. To 
complete the installation, accept the prompts as presented. A manual option is available if the 
automatic setup isn’t available. Each join method is described in the sections that follow. 
   

Join Using an Invitation E-mail Link 
If the session leader decides to send an invitation e-mail, you will receive an email with a join 
link to the session. Before you join a session, you will be prompted to enter your User ID and 
Password, or your First Name, Last Name and E-mail Address. 
   
Click the link to join the session. If this is the first time you are joining a session, the iLinc 
Client installation begins. Otherwise, you simply enter the session. 
   
In some cases, the invitation e-mail may also include a link that allows you to upload a user 
picture that will appear in the session when you have the floor. For more information on 
adding a user picture, refer to Adding or Changing Your User Picture in Chapter 2, Using 
the iLinc Communications Center. 
   



Join from Your Communications Center Home Page 
Sessions are categorized by session type on your home page. You may have one or more 
available session types, depending on your organization’s licensing options. 
   

 
Figure 16: Join a Session 

   
Your home page lists all MeetingLinc, LearnLinc, ConferenceLinc, and SupportLinc sessions 
that you are scheduled to attend or lead. You may have one or more of these session types on 
your home page, depending on the licensing options your organization has chosen. To join a 
session, locate it on your list and click the Join link for the session. 
   

Join from the Public Sessions Page 
Depending on how your session leader has set up the session, you may be able to register for 
and/or join the session from the Public Sessions page. 
   
To Register and/or Join from the Public Sessions Page: 

1.  
Access the Public Sessions page. There are two 
ways to do this: 

•  navigate to a URL the session leader sent to you 
•  click the Public Sessions link on the navigation menu 
   

 



Figure 17: Public Sessions 
   
2. Find your session on the list: 
   
If the session. . . Then ... 
allows “public 
registration” 

select the check box preceding the session name, and click Register. You 
will receive an invitation email with a Join link. 

allows “public join” click the Join link to enter the session. 

has session content 
click the Content link to view session content. Refer to Using the iLinc 
Communications Center for more information. 

   
 
 
Understanding the Session Tool Panel 
The Tool Panel is the main interface element in an iLinc session. The Tool Panel displays the 
most commonly used tools, including audio or video conferencing, the class list, Feedback, and 
Chat. These tools enable leaders and participants to interact with one another in real time. For 
example, when a participant raises his or her hand, the leader sees a hand raise notification 
immediately. 
   
The Tool Panel is configurable for each attendee in that you can collapse and expand, or dock 
and undock windows. When one window collapses or undocks, the rest of the windows move 
up in the panel area. Refer to Chapter 1, What is iLinc? for diagrams of the participant Tool 
Panels. 
   
If you are a session leader or assistant, refer to Chapter 5, Leading a Session for a diagram 
of the Leader Tool Panel. 
   
Note: Your organization or session leader can also choose to configure the Tool Panel so that it 
does not show all windows and/or session tools. If that is the case, your session interface may 
look slightly different then the diagrams in this User Guide.  
   

Interacting in Your Session 
There are several ways you can communicate in your session. You can:  
•  talk with other participants over the telephone or Internet. 
•  control your settings during a session. 
•  see the videos or photos of the leader, assistants or other participants.  
•  provide feedback upon request when your session leader asks questions using the Feedback. 
•  “instant message” participants and/or the leader using Chat. 
   
Each communication method is described in the sections that follow. 
   

Talking in a Session 
When you join your session, you will need either a telephone or computer audio equipment 
(speakers or headset).  
   
If a teleconference has been set up for this session, you will see the Primary Dial-In and 
Passcode for the session in the Join message. Once you dial-in to the conference call, you are 
able to communicate with the session leader and other participants via your telephone. If you 
need to call in again during the session, you can open the dial-in details by clicking Tools > 
Teleconference. 
   



If Internet audio is being used for this session, you will need either computer speakers or 
headphones to hear the attendees. You may also need a microphone if you want to speak 
during the session. 
   

My Controls 
Throughout your session, you may want to adjust your communication settings. For example, 
maybe you want to get the attention of the leader, the volume of your voice is too loud, or 
you can’t hear others clearly. The My Controls section of the Tool Panel gives you easy, one-
click access to many tools to adjust and enhance your experience. 
   

 
   
Raise Your Hand  
Imagine you are in the same room as all the attendees. If you wanted to ask a question, you 

would raise your hand to get the attention of the leader. Using the hand raise icon , you can 
grab the leader’s attention by virtually raising your hand. Any hand raise by a participant is 
highlighted to the leader and they can then address you so that you may ask your question to 
the entire session. 
   
Take the Floor  
In a MeetingLinc meeting and some LearnLinc class activities, you may have the ability to take 
the floor at any time. Taking the floor means that you will be driving the experience of all 
participants which includes the ability to share your desktop or applications, open and 
navigate in Powerboard files, browse web sites, display video or play audio links, or pose 
questions to the other attendees. 
   

In order to take the floor, simply click the Take Floor icon . As the new floor holder, you can 
activate and use any feature of the session, including launching Content from the Content tab, 
opening a synchronized browser window, posing a Q&A question or passing the floor to other 
participants. When you are finished as floor holder, you can pass the floor to someone else or 
wait for the next person to take the floor. 
   
Audio and Video Control  
A key component of any session is the ability to hear and be heard by participants, especially 
in meetings and class activities. Depending on how you are connecting to the audio portion of 
the session, you may have access to microphone and speaker volume or video broadcasting. 

•  
The microphone icon provides you one-click access to mute yourself or to click the 
volume meter to adjust if you are too loud or too soft. 

•  
The speaker icon provides you one-click access to turn off your speakers or to click the 
volume meter if you cannot hear the other participants speaking or if they are too loud. 

•  

The camera icon provides you the ability to either broadcast your video to your other 
participants or to turn it off. Once turned off, the floor holder cannot turn it on to view you in 
your environment. 

   

Viewing the Floor Holder 
In addition to being able to control the broadcasting of your own video image, you can also 
determine if you want to see other videos being broadcast by your floor holder or other 
session attendees. In the Floor Holder panel, you can turn on or off their video with the click 
of the camera icon. 
   



 
   
On the Floor Holder panel, you can determine if you want to: 
•  See the Floor Holder’s video 
•  See the Floor Holder’s picture 
•  See Your broadcast to other Attendees 
   
By clicking the video camera icon in the Floor Holder panel, you can either see the Floor 
Holder’s video or hide it to see their picture.  
   
The Picture-in-Picture button provides a peak at what you are broadcasting to other 
attendees: your picture or your video. If you want to turn off your video broadcast, click the 
camera icon in the My Controls panel, as mentioned earlier. 
   

Viewing Attendees 
As a participant in a session, you may have the opportunity to see the other participants that 
have joined. The Attendee panel provides a list of all attendees, including the Leader and any 
Assistants, as well as Participants of the session. Each attendee’s role is identified with a 
particular picture, so you can quickly see the makeup of your session. 
•  Leader Icon:  
•  Assistant Icon:  
•  Participant Icon:  
   
If you undock the Attendee panel, you may be able to view video being broadcast by other 
attendees. Click the undock icon and a field of pictures opens above the Tab area showing 
all attendees. If any attendees are broadcasting video, you can click their camera icon to turn 
on their video. Click the camera again to turn it off. 
   
Responding to Feedback Questions  
Feedback is a polling application that a session leader can use to solicit feedback from 
participants. When a question is asked, either verbally or in Chat, you may select an answer in 
the feedback area.  
   

 
   
When participants have shared their response, the leader can then share out the answers 
using either a pie chart (pictured) or a bar graph. 
   

Communicating Through Chat 
Chat is an instant messaging tool for quick and easy text discussions. Depending on the setup 
of your session, you may be able to chat with the leader, assistant(s) or other participants in 



the session. Clicking the drop down next to the send icon will provide you a list of those 
attendees with which you can directly chat. 
   

 
   
Sending a Private Message  
You can send a private message to the session leader(s) and assistant(s), or to designated 
participants in meetings by selecting the user’s name from the drop down list. If you want to 
send to a selected group of users, choose them from the same list. Your available groups may 
include: Leaders, Assistants, Leaders and Assistants, Floor Holder, or Everyone. 
   
Changing the Chat Font Size  
By default, your chat text displays in a small font size. To show text in a larger font select the 
Menu button on the Chat panel or from the main menu choose Tools > Chat > Font Size, 
and select Small, Medium or Large. 
   
Saving the Chat Transcript  
During your session, you and other attendees may discuss items for which you would like to 
save the transcript for future use. Be sure to save your chat before you leave the session. To 
save the chat, simply click the File menu item, click Save and then choose Chat. Using your 
computer navigation, select an appropriate place on either your local machine or any network 
drives to which you may have access. 
   
Using Emoticons  
Chat supports the use of many popular emotion icons (emoticons) when communicating with 
other session attendees. Typing certain sets of letters and/or characters will replace the text 
with a graphic image when it is sent to all other attendees. Examples of emoticons you can 
use with Chat are listed in the table below.  
   

Emoticon Key Strokes 

smile :) or :-)  

wink ;) or ;-) 

laugh :d or :-d 

sad :( or :-(  

straight face :| or :-|  

surprise :o or :-o  

be right back brb or (away) 

   

Viewing Session Content 
Types of Content 



An iLinc session may have content that appears “in session,” on a user’s home page, and/or 
on the Public Sessions page.  

•  
In-session content appears on the Content tab in a session. In-session content can also 
be set to automatically launch when participants join a session. 

•  
Content on the home page or Public Sessions page is available from a Content link on 
either page. 

   
In-session content includes files such as PowerPoint presentations, video clips, URLs, 
Powerboard files, and iLinc recordings. Session content on the homepage can include Word 
documents, Excel Spreadsheets, and Flash Movies. 
   

Launching Content 
Leader-Launched Content  
When the session leader double-clicks content item in a session, the item launches for all 
participants. The appropriate iLinc session application opens a new tab for each participant in 
which to launch the content (i.e., Powerboard, the Synchronized Web Browser, Q&A, or 
Sharing). Refer to the next section, “Using Session Tools” for a description of each session 
application that is available in a session. 
   
Participant-Launched Content  
Participants can also launch content when they have the floor. To determine who has the floor, 
check the Floor Holder panel on the Tool Panel. When you have the floor, your image will 
appear as the floor holder image.  
   
The session leader may pass the floor to a participant when that participant needs to launch 
content or run an iLinc application or, if available, anyone may take the floor at anytime. 
There are three ways to pass the floor to another attendee. The three ways are: 

1. click the Take Floor icon in the My Controls panel  
2. double-click the user’s name in the attendee panel 

3. 
select the user from the attendee panel and from the Tools menu, choose the Take Floor 
item. 

  
 

Using Session Tools  
iLinc includes a full set of flexible, easy-to-use session tools that participants and session 
leaders can use to present content and collaborate during a session. Each tool is described in 
the following sections. 
   

Powerboard 
What is it?  
Powerboard is a powerful presentation and white boarding tool that the session leader or floor 
holder can use to easily present PowerPoint presentations. Powerboard also contains markup 
tools that can be used to highlight or draw on the slide, without changing the original material. 
Powerboard can also be launched as your own workspace. Powerboard files can be saved for 
use outside of an iLinc session 
   
How is it launched?  

If this feature has been enabled for you, click the Powerboard icon in the icon bar located 
to the right of the Tabs.  

   



 
Figure 18: Powerboard Tab 

   

Synchronized Web Browser 
What is it?  
The Synchronized Web Browser allows the current floor holder (usually the session leader) to 
drive the entire group to any web-based content. 
   
How is it launched?  

If the feature has been enabled for you, click the Synchronized Web Browser icon in the 
icon bar located to the right of the Tabs.  

   

 



Figure 19: Synchronized Web Browser Tab 
   

Sharing 
What is it?  
Sharing enables the floor holder to share any file or application running on their PC during a 
session. The person sharing the application can pass the floor to another participant and the 
new floor holder can control the software, without needing the application installed on their 
machine. Sharing also includes mark-up tools for highlighting the shared application or 
desktop. 
   
How is it launched?  

If you are the floor holder, click the icon’s drop down arrow and select the Sharing type: 
Desktop, Region or Application. Sharing includes controls to pause, resume, stop or markup 
the shared item. 
   

 
Figure 20: Sharing Controls 

   
Desktop: Immediately share out your entire desktop area to all attendees. Any window 
currently open underneath the iLinc application will display, including e-mail or instant 
messaging clients. 
   
Region: Define a portion of your desktop to share to all attendees. A blue-outlined box will 
appear on your desktop and any portion of your desktop contained within the blue outline will 
be shared with attendees. You can move or adjust the size of this box at any time to change 
the shared portion of your desktop. Click the Start Sharing button on the Sharing Controls 
Panel to begin sharing this region. 
   
Application: Display a list of current open (including minimized) applications on your 
computer. You can select one or more applications by selecting the check box next to the 
name of the item. When you have selected the item(s), click the Start Sharing button to 
display these to your attendees. 
   



 
Figure 21: Application Sharing Tab 

   

Streaming Audio/Video 
What is it?  
The streaming tool provides synchronized streaming of video or audio clips compatible with 
Windows Media Player to all participants. 
   
How is it launched?  

If this feature is enabled for you, click the Audio/Video link icon in the icon bar located to 
the right of the Tabs. Enter the URL for the clip and click Go. 

   

 
Figure 22: Streaming Audio or Video Tab 



   

Q&A 
What is it?  
Q&A, iLinc’s Question and Answer application, is a powerful communication tool that can be 
used to gather information from participants. When a question file is presented during a 
session by the session leader or current floor holder, you will see the Q&A Tab. When the 
leader or floor holder asks a question, you will see the question and answer selections. 
   
Select an answer for the question. If you need to change your answer, simply select another 
answer. After gathering all the answers, the leader or floor holder may also choose to share 
answer statistics. When the leader or floor holder is finished gathering results, they may 
withdraw the question which will remove it from your Q&A Tab. 
   
How is it launched?  

If this feature is available to you, click the Q&A icon in the icon bar located to the right of 
the tabs. 
   

 
Figure 23: Q&A Tab 

   
 
Working in Breakout Groups 
What Is a Breakout Group? 
A breakout group is a meeting room to which the session leader sends a group of participants 
to work collaboratively for a set period of time. In the breakout group, you can do anything 
you can do in the main session, including sharing content, applications, whiteboard files, and 
web navigation. You can also poll fellow participants using Feedback or introduce Q&A 
questions to the group. When the breakout group time limit elapses, you and all participants in 
your group automatically return to the main session where you can share your group work 
with the rest of the session participants. 
   

Working with Your Group 
When you are added to a group by your leader, your Attendee panel will update and display 
only the other participants that are in your group. You can then chat with them or, if your 
session is set up with Internet Audio (VoIP) audio, you will be able to talk with your group 



members. If specific content items are assigned to your group, you can view the list and 
launch any item from the Content tab. 
   

Time Limits for Breakout Groups 
Your leader may set a restricted time limit for the group breakout. If a time limit is used, you 
will be returned back to the full session with all participants automatically. Your session will 
then proceed with the leader or floor holder continuing the presentation or discussion.  
   

 
   
To view the time left in the group, look to the timer in the My Controls panel. To leave the 
group before the time has run out, click the exit icon. You will be returned to the main 
session.  
   

Understanding Floor Control in a Breakout Group 
In a Breakout Group, each attendee is given equal control over the session. Participants can 
take or pass the floor at any time to gain control of audio and session content. To take the 
floor, simply click the icon in the My Controls panel or double-click your name in the Attendee 
panel. 
   
To avoid interrupting each other, you may want to click the Raise Hand icon to indicate that 
you would like to take the floor. The current floor holder can then wrap up whatever he or she 
is doing before you take the floor. If groups use the raised hand approach, the floor holder can 
click the participant's name and then click the Give Floor icon to pass the floor, or just wait 
until the hand raiser takes the floor. 
   
When participants have the floor, they can talk to the group and control any applications or 
content in use. They can also open new applications or content. 
 
Leaving a Session 
When you are ready to leave or exit the iLinc client, select Menu > Exit, at the top of the 
iLinc Tool Panel. Additionally, you can click the x in the upper most right corner of the 
application window. You will be prompted to confirm you desire to leave the meeting or 
session. 
   
 


